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CHAPTER 1. INTRODUCTION 
LabSmith’s uProcess™ is a platform comprised of a suite of hardware and software products 
that simplify construction and control of microfluidic systems.  

uProcess automated devices work together with CapTite™ microfluidic interconnect products to 
make it easy to build and rebuild micro- and nano-fluidic circuits. All products are inter-
compatible and quick to assemble, taking the hassle out of fluid routing. 

SPS01 Programmable Syringe Pumps deliver volumes up to 100 microliters, with resolution 
as low as 2 nanoliters. The pump body design allows syringes to be easily removed and 
replaced, providing a wide range of volumes with a single pump.  

AV201 Automated Selector Valves provide 2-position, 3-port switching, with zero dead 
volumes and low swept volumes. 

uProcess Software provides a simple interface for configuring and controlling uProcess 
devices and for creating automated processes for coordinated control.  

This user guide will show you how to connect, configure and control uProcess devices, how to 
install and operate uProcess software, and how to create automated flow control processes.  

Please contact LabSmith or visit www.labsmith.com for user manual, software and firmware 
updates. 

Equipment List 
uProcess software communicates with uProcess devices through the Electronic Interface 
Board (EIB). The EIB is typically connected via communication cable through one of the 
LabSmith breadboards (uPB, iBB, etc.), enabling control over multiple devices (Figure 1).  

 

 
Figure 1. uProcess System Components. 
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The EIB can also connect directly to a single SPS01 syringe pump, or to a 4VM valve manifold 
to operate up to four AV201 valves, without a breadboard.  

The EIB connects to the computer via the RS232 cable, or to a USB port with optional RS232 to 
USB adapter.  

Required Equipment 
- PC-compatible computer running Windows® XP, NT or 7. 
- uProcess™ software (installation disk included) 
- Electronic Interface Board (EIB) 
- 12V power supply for EIB 
- RS232 serial interface cable 
- 20-pin communication cable. 

Optional Equipment 
- uPB or iBB breadboard 
- RS232 to USB adapter cable 
- SPS01 Programmable Syringe Pumps 
- SPS01 syringe glass/plunger set 
- Plunger installation wrench 
- hex wrench 
- syringe installation screws (M3) 
- label stickers. 
- AV201 automated valve 
- 4VM4 valve manifold (one manifold per up to four valves). 
- Ribbon connector 
- Valve installation screws (2-28). 

Cautions and Warnings 
When working with uProcess devices and accompanying electronics, follow standard 
procedures to protect your devices from excessive static electricity, power fluctuations, etc. 

Read and understand all documentation for your individual uProcess devices and components 
before connecting the equipment. 

CAUTION: Extra care must be taken when using the electronic components with fluids. 
Breadboards are designed with the electronics on the left side; take care not to 
introduce liquids to this side of the breadboard.  
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Getting Help 
This guide is your main source for information on operating uProcess software. Choose 
Help>About uProcess, then click the Open User Manual link to browse this manual 
electronically, in Adobe® Acrobat® PDF format. 

The LabSmith web site (www.labsmith.com) also includes helpful applications notes and other 
technical information to help you use uProcess software and devices. If you are unable to find 
the information you need, please contact our technical support team at (925) 292-5161, or email 
us at support@labsmith.com. Be prepared to give the software version. To determine the 
software version number, select Help>About uProcess. 

About This Manual 
Several conventions are used throughout this manual to highlight important features and 
concepts: 

Menu>Option Menu bar selections will be shown in bold text, with descending options 
separated by the “>” symbol. For example, Help>About uProcess indicates that you should 
click the Help menu, and then click About uProcess. 

Note Notes indicate helpful tips or additional information. 

CAUTION These notes signify important considerations that will help you to avoid losing data 
or damaging hardware. 

Italics When browsing the electronic version of this manual, click on these italic cross-
references to view other pertinent sections of the manual.  

 

Choose Help>About uProcess, then click the Open User Manual link to browse the electronic 
version of this manual. 

 

http://www.labsmith.com/�
mailto:support@labsmith.com�
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CHAPTER 2. GETTING STARTED  

Connecting an Electronic Interface Board 
Though the devices you use with your uProcess system will vary, some basic hardware is 
common to all uProcess setups.  

Every system requires at least one Electronic Interface Board (EIB), which can control up to 110 
SPS01 Syringe Pumps and/or 4VM Valve Manifolds. Since each valve manifold can control up 
to four valves, one EIB can thereby control hundreds of devices. 

Although over 100 devices can be sequentially controlled on an EIB, only 10-15 devices can be 
actuated simultaneously. More than one EIB can be connected to the computer at one time 
when a very large number of devices or concurrent operations are required. 

To connect an EIB to the computer:  

Connect the serial interface cable from the COM port on the EIB to the computer’s RS232 port. 
An optional RS232 to USB adapter allows you to connect the EIB to a USB port instead. 

Connect the power transformer from the EIB to a wall outlet. The two indicator lights will flash 
when powered up, after which the Power light will stay illuminated red. The COM light will 
illuminate when the EIB is communicating with the computer.  

Adding a Breadboard 
An EIB can be connected to a single syringe pump or valve manifold; however, it is typically 
used with one of the LabSmith breadboards (uPB-5, uPB-8, iBB) for mounting multiple 
components (Figure 2). Between 5 and 8 uDevices (syringe pumps or valve manifolds) can be 
connected to a single breadboard. The uPB-8 and iBB breadboards can be daisy-chained 
together by connecting a ribbon cable from the female connector on the left side of the board to 
the male input on the next board.  

   
Figure 2. uPB-05 and uPB-08 Breadboards with uDevices. 

To add a breadboard, connect the 20-pin communication cable from the Device Bus port on the 
EIB to the female connector on the breadboard. Line up the tab on the communication cable 
with the notch on the connector.  
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Installing Automated Valves 
To install and configure AV201 automated valves: 

Plug the VM4 valve manifold into one of the connectors located along the side of the 
breadboard. 

Secure the automated valve(s) to the desired location on the breadboard using two ¼” 
breadboard mounting screws. 

Use a ribbon connector to connect the automated valve to a port on the valve manifold. Observe 
the label on the valve and manifold to ensure the cable is connected at the correct orientation. 

Installing Syringe Pumps 
To install an SPS01 programmable syringe pump, plug the syringe pump body into one of the 
connectors located along the side of the breadboard. Two M3 screws may optionally be used to 
more securely attach the syringe to the bottom of the breadboard. 

Installing uProcess Software 
uProcess software runs on any PC-compatible computer running Microsoft Windows® XP, NT or 
7. The software requires approx. 5MB of free disk space. To install uProcess: 

1. Insert the uProcess for Windows CD. 

2. Double-click SETUP.EXE and follow the on-screen instructions. 

3. To run the software, double-click the uProcess icon on your desktop, or choose 
Run>uProcess>uProcess. 
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CHAPTER 3. UPROCESS SOFTWARE 

Software Interface 
The uProcess Dashboard consists of a menu bar, toolbar, and configurable windows (Figure 
3). Unique menu and toolbar commands will be described in the body of the text below. A 
complete listing of all menu and toolbar commands can be found in Appendix A. Menus, 
Toolbars, Window Controls. 

 
Figure 3. uProcess Dashboard. 

The uProcess Dashboard consists of 5 windows, described below. You can customize the 
placement of the windows on the dashboard and a number of other features about the interface. 
See Customizing the Dashboard for more on customizing the window layout. 

uDevices Window 
The uDevices Window is used to view, add, and configure individual devices and EIBs (Figure 
4).  It shares the left side of the Dashboard with the Sequencer Window. Click the tabs at the 
bottom of this area to switch between the two windows.  
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Figure 4. uDevices Window. 

 

Sequencer Window 
The Sequencer Window is used to view a sequence program (Figure 5). The uDevices Window 
is used to view, add, and configure individual devices and EIBs.  It shares the left side of the 
Dashboard with the Sequencer Window. Click the tabs at the bottom of this area to switch 
between the two windows.  
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Figure 5. Sequencer Window. 

Output Window 
The Output Window is used to monitor device communications or to debug and monitor a 
sequence program (Figure 6). By default this window appears at the bottom of the dashboard.  

 
Figure 6. Output Window Showing Script Parsing Tab. 

The Output Window contains three tabs: 

Script Parsing displays any errors in the current automated process. 

Sequence Status indicates which process is running and notes any errors incurred. 

Communications shows the status and history of communication between the Electronic 
Interface Board and the computer. 

Main Window 
The Main Window is used to control and monitor devices, as well as to construct, edit, and 
monitor sequence programs. Its contents change depending upon what is selected in the 
uDevices Window or Sequencer Window. The Main Window cannot be undocked or hidden. 
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Communicating with the uDevices 
Once the uDevice hardware and uProcess software have been installed you are ready to 
communicate with the devices. 

1. Launch the uProcess software. 

2. Right-click on Interfaces in the uDevices Window and choose New Interface.  

3. Select the computer port to which the EIB is connected, and click OK. If multiple EIBs 
are installed, repeat this step for each EIB. 

Your uProcess dashboard should now look similar to Figure 7. 

 
Figure 7. uProcess Dashboard. 

The uDevices Window contains a tree structure listing each EIB and the devices installed 
under each. In Figure 7 two EIBs are connected. Two SPS01 syringe pumps are connected to 
the EIB on COM11. A 4VM, and a SPS01 syringe pump are connected to the EIB on COM1.  

The devices connected to a particular EIB can be hidden by clicking the “-“ button next to the 
EIB name in the uDevices Window. Click the “+” button next to the EIB to display its devices. 

Note: Breadboards will not appear as device in the uDevices tab since there are no functions 
to control on the breadboard itself. 

The Main Window will show one of two views.  

The default view is the Device Control Overview Window, which can also be viewed by 
clicking Interfaces in the uDevices Window. The Device Control Overview allows limited control 
of all devices. It is also the view that will be used to program sequences using the programming 
wizard (see Create a Script Using the Wizard). 

By clicking on one of the individual device names (syringe pump or 4VM) in the uDevices 
Window, the Individual Device Control panel opens. Figure 8 shows the control panel for a 
syringe pump, while Figure 9 shows controls for a 4VM valve manifold. 
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Figure 8. Control Panel for Syringe Pump. 

 
Figure 9. Control Panel for Valve Manifold. 

Online and Offline 
The communication status of each device is shown in the uDevices Window. To monitor or 
control a device, the device, its EIB, and the interface must all be online. 

As shown in Figure 10, the icon to the left of each device will indicate whether it is Offline (not in 
communication with the computer) or Online (in communication). In this example the EIB on 
COM11 is offline, and the EIB on COM1 is online.  

To change the status of a device or EIB, right-click the device in the uDevices Window and 
check/uncheck the Online setting. 

To toggle all connected devices to online or offline, click the Online toolbar button . 

Note:  An EIB will go offline if there is a communication error between the COM port and the 
EIB. Two red lights on the EIB also indicate a communication problem. This error 
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typically indicates a bad cable connection. The Communications tab of the Output 
Window lists a history of the EIB port communication status.  

 
Figure 10. Devices Shown Offline (EIB on Com11) and Online (EIB on COM1). 

Device Naming and Numbering 
Every uDevice (syringe pump or valve manifold) is identified by an address and name.  

Note: Clicking on the device name in the uDevices Window  will cause the indicator light on the 
device to flash red/green. This feature aids in quickly identifying each device.  

Device Address 
Each device attached to an EIB must be assigned a unique address between 0 and 110. If you 
purchased several devices at the same time from LabSmith they will be preconfigured with 
unique addresses.  

Device addresses are shown next to each device in the uDevices Window and also on in the 
Address field of the Device Control Panel.  
Note: If multiple devices on the same EIB have identical addresses they may not appear in 

the uDevices Window list, or they may appear as one device. Operating in this 
condition can cause unpredictable results.  

 If two devices with the same address are installed, one will need to be removed before 
the address can be changed.  

Note:  The address assigned to each device is independent of its physical position on a 
breadboard. On the control panel for each EIB, devices will be displayed in numerical 
order based on the device address, not their position on the breadboard. 

To change a device address: 

1. Select the device in the uDevices Window. 

2. Choose Configuration. 

3. Select a Device Address from the dropdown menu and click OK.  

You can also right-click on the device icon in the uDevices Window and choose Change 
Address. 

Tip:  Use the included yellow labels to mark the device address on each syringe pump or 
valve manifold for easy identification. 
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Device Name 
The default device name for the syringe pump is “LabSmith SPS01”. The default device name 
for the 4VM is “4 Valve Manifold”. 

You can rename the devices. The name may have a maximum of 16 characters and may not 
include ‘;’, ‘<’, ‘>’, ‘*’ or ‘=’. Names may include tabs and spaces but may not start or end with 
them. Names are case-sensitive.  

If you will be using automated processes, each installed device name must be unique.  

To change a device name: 

1. Select the device in the uDevices Window. 

2. Choose Configuration. 

3. Type the new device name in the Name field.  

You can also right-click on the device icon in the uDevices Window and choose Rename. 

Adding or Removing uDevices 
To add or remove a device: 

- Click the Online toolbar button  to toggle all interfaces offline. 
- Physically add or remove the uDevice(s) to or from the breadboard. 

- Click the Online toolbar button  to toggle all interfaces back online. 

Click the Rescan toolbar button  to check for new devices. Any added devices should now 
appear in the uDevices Window, while any removed devices will be gone. 

Note:  To rescan an individual EIB right-click its icon in the uDevices Window, then choose 
Rescan Devices. 
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CHAPTER 4. REAL TIME DEVICE CONTROL 
uProcess lets you control connected devices manually or as part of an automated process. 

Device Control Panel  
When you click on a device in the uDevices Window its Device Control Panel will appear in 
the Main Window, as shown in Figure 8 and Figure 9.  

Common Controls 
All devices have the following commands in common (Figure 11): 

 
Figure 11. Controls Common to All uDevice Control Panels. 

Configuration  Opens the Configure dialog box for the device. Detailed descriptions of the 
configuration options are described in Device Naming and Numbering, 
Changing the Syringe Pump Glass Assembly and Calibrating the Syringe 
Pump. 

Online?  When this box is checked, uProcess will send commands and receive data 
from the device. The EIB to which the device is connected must also be online. 
Uncheck the box to take the particular device offline. 

Monitor?  When this box is checked, uProcess will continuously read and display the 
device’s status. Uncheck the box to stop monitoring activity for the device. 

 Apply Settings Now updates the uDevice to the selected settings. 

  Update Continuously updates the uDevice continuously as the settings change. 

  Stop the uDevice stops the current action of the device and deselects the Update 
Continuously button. 

Note:  Pressing the Stop button in a Device Control Panel affects only the selected device. 

To stop all devices, use the Stop All uDevices  toolbar button or the Stop the 
uDevices button in the Device Control Overview Window. 

Syringe Pump Control Panel 
In the uDevices Window click on the icon for a syringe pump to view its Control Panel (Figure 
12). 
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Figure 12. Controls for an SPS01 Programmable Syringe Pump. 

In addition to the Common Controls described earlier you can view/perform the following: 

Current Syringe Pump State 
The following features are only applicable when the “Monitor?” box on the Control Panel is 
checked. 

The diagram at the bottom of the window shows the current pump state (Figure 13).  

 
Figure 13. Syringe Pump Diagram.  

The Current Volume of the syringe is indicated by the colored portion of the syringe diagram. 
When the plunger is stationary the fluid volume is shown in blue. When the plunger is pulling 
(loading) the color will change between blue and red, and when it is pushing (dispensing) the 
color will change between blue and green.  

The Motion Indicator shows the direction the syringe plunger is moving: 
- Red = syringe plunger is pulling (loading) 
- Green = syringe plunger pushing (dispensing) 
- Grey = syringe plunger is not moving. 

The red Stall Indicator will appear if the syringe pump has stalled. It will stay on until you click 

the Stop the uDevice  or Stop All uDevices  button. 

Position Control 
The position of the syringe plunger can be set using one of several methods (Figure 14): 
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Figure 14. Set Syringe Position.  

1. Move to a set point by clicking and dragging the Set Point slider bar to the desired 
volume. 

2. Move to a set point by typing a volume into the field to the right of the Set Point slider. 

3. Enter an Increment into the field above the Set Point slider, then click the arrows on 
either side of the box to increase/decrease the set volume.  

4. Click the |< and >| buttons to move to the maximum extents of the plunger travel.  

5. Click <<<. <<, or < to increase the volume by 10%, 1% or 0.1% of the maximum volume. 
Similarly, click >>>, >>, or > to decrease the volume by 10%, 1% or 0.1%. 

In all cases the plunger will move to the new volume at the speed set in the Speed Control. 

Speed Control 
To set the flow rate/speed of the pump, click and drag the Speed Control to the desired flow 
rate, or type the flow rate into the ul/min box (Figure 15). The minimum and maximum flow 
rates for the syringe pump are shown below the slider bar.  

 
Figure 15. Speed Control Settings. 

Optimizing Syringe Pump Performance 
The syringe pump is designed for optimal accuracy in the push (infuse) direction. The pump 
motor design includes an anti-backlash spring, which can cause minor volume inaccuracy in the 
pull direction. In addition, when changing the syringe direction from pull to push, or vice-versa, 
you may notice a slight delay before the syringe plunger starts advancing. The volume 
inaccuracy and duration of the delay will vary depending on the syringe size, set speed, system 
back pressure, and fluid viscosity.  

To improve the timing and volume accuracy of an infusion we recommend pushing a small 
volume of fluid prior to starting the timed infusion. For example, if you want to pull 10 ul of fluid 
from a reservoir and then push (infuse) it into a process, we recommend pulling 11 µl of fluid, 
then push 1ul back into the reservoir before switching your valve to the infuse position.  

Valves Control Panel 
Click a valve manifold in the uDevices Window to view its control panel (Figure 16). 
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Figure 16. Controls for a 4VM valve manifold and AV201 automated valves. 

Note: All 4 valve positions on a 4VM will be displayed, regardless of how many valves are 
actually installed. 

In addition to the Common Controls described earlier you can view/perform the following for 
each connected valve: 

No change The valve will remain in its current position. 

A The valve will allow flow to the left. 

Closed The valve will close. 

B The valve will open flow to the right. 

The valve states are shown in Figure 17. 

 
Figure 17. Automated Valve Positions, Looking Down at Valve. 

A box to the right of the state buttons will be checked to show the valve’s current state. If 
Update Continuously is selected, the valve will move immediately when you select a new 
position, and the green button to the left of that position will be marked. When Update 
Continuously is not selected, choose the new position (its green indicator will be marked), then 
click Apply Settings Now to move the valve (the check mark for the new position will be 
marked). 

Current Valve State 
These features are only applicable when the “Monitor?” box on the Control Panel is checked. 

The valve position will remain Indeterminate until the valve direction is set or changed. Once the 
position has been set, the current valve state will be indicated by a check mark next to the 
correct position.  
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CAUTION:  The software does not detect whether a valve is actually installed in each position 
in a manifold. If the valve position is changed with no valve installed, and then a 
valve is installed, the position indicator could be incorrect. 

Device Control Overview Window 
The previous section explained how to control uDevices through their individual control panels. 
The Device Control Overview window gives you a convenient way to view and set the controls 
for multiple devices, which is particularly useful when setting up the steps of an automated 
process, as we’ll show later. 

To view the Device Control Overview window click Interfaces in the uDevices Window 
(Figure 18). 

 
Figure 18. Device Control Overview Window. 

The controls at the top of the window affect all devices: 

  Update Continuously updates all devices automatically as you change the settings. 

  Apply Settings Now updates all devices to the currently selected settings. If Update 
Continuously is selected, this button will not be available. 

  Stop the uDevice stops the action of all devices. Updating Continuously will be 
unchecked. 

Click Monitor All to continuously read the status of all devices. Click Monitor None to stop all 
monitoring. 

Each device will be listed below the main controls. To the left of each device are the following 
two buttons: 

When the Do Not Change uDevice Settings  button is depressed, no changes will be 
made for this device when you click Apply Settings Now. Click the button again to allow setting 
changes to be made. 
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Click the Stop This uDevice  button to stop the action of the particular device (and leave 
all other devices unaffected). 

Syringe Pump Settings 
These controls are similar to those on the syringe pump controls screen. Click and drag the 
Target Volume slider, or enter the desired volume in the Target box. Click and drag the Flow 
Rate slider, or enter the desired rate in the Flow Rate box.  

If Apply Settings Continuously is selected, then the pump will move immediately to the new 
target volume, at the selected flow rate. If Apply Settings Continuously is not selected, the 
pump will remain at its current settings until you click Apply Settings Now. 

The indicator light on the syringe pump will flash red/green when it is first powered up. It will 
glow green when the syringe is pushing and red when it is pulling. 

Automated Valve Settings 
The Automated Valve controls are similar to those on the Valves Control Panel. For each 4VM 
manifold, four valves are shown (regardless of the number of valves actually attached). 

For each valve you wish to change, click the box next to Open A, Closed or Open B (these 
states are described in Valves Control Panel).  
If Apply Settings Continuously is selected then each valve will change position immediately, 
and the box next to the new state will be checked.  

If Apply Settings Continuously is not selected, then the box showing the current valve 
position(s) will remain checked, and the box showing the desired position will be shown as a 
solid green square (Figure 19). When you click Apply Settings Now the valve(s) will change 
state, and the new valve positions will be checked. 

 
Figure 19. Changing a Valve’s State in the Device Overview Window. 

The indicator lights on the valve will illuminate when it is being actuated. A red light indicates 
that it is being actuated to the “A” position, while a green light indicates it is being actuated to 
the “B” position.  

The indicator light on the 4VM manifold is green when the position of at least one valve is 
indeterminate. The light will momentarily turn red whenever a valve has reached its open 
position.  
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CHAPTER 5. AUTOMATED CONTROL 
An automated script is a series of steps for controlling one or more automated devices. Each 
step can change the state of multiple devices. A script can be created using the Process 
Wizard, and it can be created or edited using the built-in text editor.  

Opening Script Files 
Each automated script is stored as a file with a .usq extension. To open an existing script click 

the Open  toolbar button, then browse for the correct file. Its contents will appear in the 
Main Window (Figure 20). 

 
Figure 20. Text of an Automated Process. 

Create a Script Using the Wizard 
The Process Wizard provides a simplified interface for quickly generating automated scripts. 

Note:  Each installed syringe pump and 4VM must have a unique name, regardless of 
whether it is used in an automated script. See Device Name. 

To create a script using the Process Wizard: 

1. Click the New toolbar button, or choose File>New. If a process is currently open, its 
contents will be copied into this new script. 

2. Select the uDevices Window. 

3. Click Interfaces to view the Device Control Overview Window. 

4. Set the initial target state for each device. 

5. Click the Save as New Sequence Step  button. The Creating a New Sequence 
Step dialog box will open (Figure 21). 
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Figure 21. Creating a New Process Step Dialog Box. 

6. If desired, enter a descriptive Step Name. Step names may have a maximum of 16 
characters and may not include blanks or ‘;’, ‘<’, ‘>’, ‘*’ or ‘=’.  

7. Select how the script should respond after changing the uDevice settings: 

a. Select Pause, then enter the duration to pause before continuing with the 
process. The pause duration begins as soon as the step starts. 

b. If you select Wait until all devices are finished, uProcess will wait until all 
devices have completed their functions before continuing on with the process. 

c. Select Do Not Wait to immediately continue on to the next step. 

8. Select how the script should continue after this step: 

a. Select Continue to continue to the next step in the process. If a new step is not 
added the process will end. 

b. Select Loop to step to jump to another process step. Select the target step from 
the drop-down list, then enter the number of times the step should loop.  

c. Click OK. The step will appear in the Sequencer Window, and its text will 
appear in the Main Window. 

Save a Script File 
Click the Save toolbar button, or choose File>Save, to save all changes to the current script file. 
If the file has not yet been saved you will be prompted to provide a name and file location for it. 

Choose File>Save As to store the current script under a new file name. 

Run, Pause and Quit a Script 

When a script is open and error-free, the Run  toolbar button will be available. Click Run to 
initiate the process. All steps will be performed in order. 

While a script is running you can click the Pause  toolbar button to pause the automated 
process. Click Pause again to continue the script from that point. 
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Click the Quit Process  toolbar button to quit running the automated script.  

Note: When you Pause or Quit a script, devices that were moving will continue until they 

reach their target states. Click the Stop All Devices  toolbar button to stop all 
device activity. 

While an automated script is running, the Sequence Progress tab of the Output Window will 
indicate the current status of the script and will report any errors encountered (Figure 22). 

 
Figure 22. Sequence Progress Tab of the Output Window 

. 

Automated Script Functions 
 
SetValves   

ManifoldName: SetValves x x x x  ; sets valve positions 
 
ManifoldName  defined name of 4VM (must be defined in script header) 
x x x x   position of valves 1, 2, 3, and, 4, respectively, where 

x = 0 no change 
x = 1: open valve to ‘A’ 
x = 2: close valve 
x = 3 open valve to ‘B’ 

 
 Example:  4VM_A: SetValves 1 0 3 2 
 
SetFlowRate   

SyringeName: SetFlowRate rate units; sets syringe flow rate 
 

SyringeName  defined name of syringe (must be defined in script header) 
rate    syringe flow rate (positive number) 
units   flow rate units, acceptable units include 

ul/min (default) 
ul/s 
nl/min 
nl/s 

 
Example: Reagent: SetFlowRate 50 ul/s 

 
MoveTo   

SyringeName: MoveTo vol units ; sets syringe move to position 
 
SyringeName  defined name of syringe (must be defined in script header) 
vol    syringe volume to move to 
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units   volume units, acceptable units include 
ul (default) 
ml 
nl 

 
Example: Reagent: MoveTo 20.5 ul  

 
Stop    

DeviceName: Stop ; stops device 
 
DeviceName defined name of 4VM or syringe (must be defined in script header) 
 

Note:  The Stop command is added via the Process Wizard using the  button (Stop this 
uDevice) in the Device Control Overview window. 

 
Example: Reagent: Stop  

 
Pause    

<Pause> duration units ; pauses script for specified duration 
 
 Duration  length of pause 

units   pause duration units, acceptable units include 
ms (default) 
s 
us 

 
Example: <Pause> 1 s  

 
WaitAllDone   

<WaitAllDone> ; pauses script until all processes are complete 
 
Example: <WaitAllDone>  
 

WaitDone   
<WaitDone> DeviceName  ; pauses script until all defined device is complete 
 
DeviceName defined name of 4VM or syringe (must be defined in script header) 
 
Example:  <WaitDone> Reagent 

 
 Note:  The WaitDone function cannot be added using the Process Wizard 
 
Loop   

<Loop> StepName cycles  ; loops back to named step for specified number of cycles 

StepName  defined name of step in script 

cycles  number of times to loop;  

Example:  <Loop> FillStep 6 
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Note: leave blank for endless loop 
 

Break     

 <Break>  ; automatically activates the pause  toolbar button. 

Sequence pauses until the pause toolbar button is pressed. This function is useful for 
testing a script, or if you have an event with unpredictable timing that you need to wait 
for before resuming a script. 

Example:   <Break>  

   Note:    The Break function cannot be added using the Process Wizard 

  
Quit     

 <Quit> ; quits the script, steps following this function will not be run.  

This function will not stop a device that is already in process, for that use the Stop 
function. 

Example:   <Quit>   

Note:    The Quit function cannot be added using the Process Wizard. 

General Formatting Rules 
Devices  
Individual devices are defined in the script as follows: 

Syringes: 

*DeviceName = SPS01 size ul 

Where size is the syringe size (4, 8, 20, 40, or 80) 

Valve Manifolds 

  *DeviceName = 4VM01 

DeviceName must match name defined in the uDevice configuration (see Device 
Naming and Numbering). 

 
Comments  
Comments can be added to the script using a semicolon (;). Anything after the semicolon is 
treated as a comment: 
 <Pause> 1000 ms; to allow time to monitor reaction 

 
Step Name 
Step names may have a maximum of 16 characters and may not include blanks or ‘;’, ‘<’, ‘>’, ‘*’ 
or ‘=’. 

Edit Automated Script Text 
As mentioned earlier, you can create a script using the Process Wizard, or you can create/edit 
the text directly. 
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To view and edit the text of a script, click on the Sequencer window, then select Sequencing 
Script. The text will appear in the Main Window. Here is a sample script: 

 
*Reagent Syringe = SPS01 20 ul 

*Reagent Manifold = 4VM01 

Open_Reservoir 

 Reagent Manifold: SetValves 1 0 0 0 

 <WaitAllDone> 

Fill_Syringe 

 Reagent Syringe: SetFlowRate 50.000 ul/min 

 Reagent Syringe: MoveTo 10.000 ul 

 <WaitAllDone> 

Open_Process 

 Reagent Manifold: SetValves 3 0 0 0 

 <Pause> 1000 ms 

Deliver_Reagent  

 Reagent Syringe: SetFlowRate 10.000 ul/min 

 Reagent Syringe: MoveTo 0.000 ul 

 <WaitAllDone> 

 <Loop> Fill_Syringe 10  

 

The first lines define the devices used in the script. Note that the devices are defined by name 
rather than address, so the names of all devices must be unique. 

Below these declarations, each step is listed in order. For clarity, all state changes within each 
step are indented below the step name. 

When learning to edit the text it may prove helpful to create a script using the Wizard, then to 
edit the generated text as the basis for your new script.  

Most standard text editing functions are available, including Cut, Copy and Paste. 

Other Sequence Script Functions 
Print Script Text 
Click the Print toolbar button to print out the text of the current process. 

Script Errors 
uProcess will review the script as you create or edit it and will indicate errors as follows: 

1. If the script has an error the Run button will be grayed out and the script cannot be run. 

2. The Script Parsing tab of the Output window will display the message ***The script 
cannot be run until the script errors are resolved***. 

3. The Script Parsing tab of the Output window will also list the line number and specific 
error. 

4. The step with the error will show a “broken” icon in the Sequencing Script list. 
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In the example shown above, the errors are in lines 6 and 17. The step name in line 6 (Fill 
Syringe) contains spaces, which are not allowed. The Loop command in line 17 is pointing to a 
step named “Fill_Syringe”, which cannot be found. If “Fill Syringe” in line 6 is replaced with 
“Fill_Syringe”, the errors will be resolved and the script will be ready to run.  

 
Figure 23. Sample script showing errors in Lines 6 and 17.  

Missing Devices 
All of the devices referenced in a process must be available for the process to function. If you 
open a script which calls out a device that is not present error messages will appear in the 
uDevices Windows, the Script Parsing tab of the Output Window, and the Main Window 
(Figure 24). 
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Figure 24. Error Message: Referencing a missing device. 

For this example, the script references “Reagent Syringe”, but the syringe is named “Syringe 1”. 
This error can be resolved by renaming the device (see Device Naming and Numbering) or 
changing the script. To change the scrip: 

Right click on “Reagent Syringe” under the Missing devices tab and select Rename … 

Change the name to “Syringe 1” and click OK. 

Figure 25 shows how all instances of “Reagent Syringe” in the script have now been changed 
to “Syringe 1”. 
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Figure 25. All instances of “Reagent Syringe” have been changed to “Syringe 1” in this script. 

Example Script 
In the example shown in Figure 26 a syringe pump is attached to an automated valve, a supply 
reservoir and a downstream process. The syringe will first pull fluid from a reservoir connected 
to the “A” port of the valve. The valve will then switch to the “B” position, and the syringe will 
deliver the fluid to the downstream process. 

 
Figure 26. Hardware Setup for the Sample Process. 

For this example the following devices are installed on one EIB: 
- One 20µl syringe named “Reagent Syringe” 
- One 4VM manifold named “Reagent Manifold”, with one valve connected 

at position 1. 

The automated script is created as follows: 

1. In the uDevices Window select Interfaces to display the Device Control Overview 
Window (Figure 27). 
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Figure 27. Installed Devices Shown in Device Control Overview Window. 

2. Set the position for Valve 1 on “Reagent Manifold” to Open A. 

3. Depress the Do Not Change uDevice Settings  button next to the Reagent 
Syringe. 

4. Click the Save As a New Sequence Step  button. 

5. Name the new step “Open_Reservoir.” 

6. Select Wait until all devices are finished and Continue. 

7. Click OK to add this step to the script and go on to the next step. 

8. Set the Target Volume for the syringe named “Reagent Syringe” to 10 µl and the Flow 
Rate to 50 µl/min (Figure 28). 
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Figure 28. Step “Fill_Syringe” Settings. 

9. Depress the Do Not Change uDevice Settings  button next to the Reagent Valve. 

10. Click the Save As a New Sequence Step  button. 

11. Name the new step “Fill_Syringe.” 

12. Choose wait until all devices are finished and Continue (Figure 29). 

 
Figure 29. Step 1 Settings. 

13. Click OK to add this step to the script. To view the process thus far, click the 
Sequencer Window tab then click on any step in the sequencing script (Figure 30). 
Select Interfaces in the uDevices Window to return to the Device Control Overview 
Window and continue building the script. 
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Figure 30. Step 1 Shown in the Sequence Tab and Main Window. 

14. Set the position of Valve 1 to Open B and depress the  button for the Reagent 
Syringe. 

15. Click the Save As a New Sequence Step button and name the new step 
“Open_Process”. 

16. Choose Pause and set the time for 1 s (1000 ms). Choose Continue and select OK to 
go on to the next step. 

17. Set the Target Volume to 0 and the Flow Rate to 10ul/min and depress the  button 
for the Reagent Valve. 

18. Click the Save as a New Sequence Step button. 

19. Name the step “Deliver_Reagent”. 

20. Select wait until all devices have finished. 

21. Select Loop to Step and choose Fill Syringe from the drop down menu. Set the loop 
count to 10, and the process will repeat for 10 iterations. (Figure 31). 
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Figure 31. Deliver_Reagent Step Settings. 

22. Click OK. Again, select the Sequencer Window tab and click on a step in the script to 
view the complete script (Figure 32). 

 
Figure 32. The Complete Example Script. 

23. Press the Run button to initiate the automated script. 

 

When a script is running, the current step will highlighted in the Main Window to allow tracking 
of the script progress. The status of the devices and the step progression can be monitored real 
time. As shown in the figure below, the Device Control Overview Window shows the real time 
positions of the syringes and valves; the Sequence Status tab of the Output Window shows 
which step is currently running and the number of iterations which have been completed. The 
bottom left corner of the window shows how long the script has been running (Figure 33). 
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Figure 33. Sequence Status Tab. 

Syringe Pump Volume vs Delivery Time 
In the above example the syringe is set to deliver 10µl of reagent at 10µl/min. In order not to 
overshoot the delivery of the reagent, the syringe will slow down just before reaching the target 
volume; therefore, the delivery time may be more than 1 minute. This is most pronounced when 
delivering at high flow rates.  

For some processes the infuse time may be more critical than the total delivery volume. For this 
case you can use the <Pause> and <Stop> functions together to set the infuse time. The script 
from the above example is shown below.  

 
*Reagent Syringe = SPS01 20 ul 

*Reagent Manifold = 4VM01 

Open_Reservoir 

 Reagent Manifold: SetValves 1 0 0 0 

 <WaitAllDone> 

Fill_Syringe 

 Reagent Syringe: SetFlowRate 50.000 ul/min 

 Reagent Syringe: MoveTo 10.000 ul 

 <WaitAllDone> 

Open_Process 

 Reagent Manifold: SetValves 3 0 0 0 

 <Pause> 1000 ms 

Deliver_Reagent  

 Reagent Syringe: SetFlowRate 10.000 ul/min 

 Reagent Syringe: MoveTo 0.000 ul 

 <WaitAllDone> 

 <Loop> Fill_Syringe 10  
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The total volume delivered is 10µl, which at 10µl/min should take approximately 1 minute. If a 
delivery time of exactly 1 minute is desired, the script could be modified as follows (changes are 
in bold): 

 
*Reagent Syringe = SPS01 20 ul 

*Reagent Manifold = 4VM01 

Open_Reservoir 

 Reagent Manifold: SetValves 1 0 0 0 

 <WaitAllDone> 

Fill_Syringe 

 Reagent Syringe: SetFlowRate 50.000 ul/min 

 Reagent Syringe: MoveTo 11.000 ul ;provide extra volume 
so the syringe won’t stop prematurely 

 <WaitAllDone> 

Open_Process 

 Reagent Manifold: SetValves 3 0 0 0 

 <Pause> 1000 ms 

Deliver_Reagent  

 Reagent Syringe: SetFlowRate 10.000 ul/min 

 Reagent Syringe: MoveTo 0.000 ul 

 ;<WaitAllDone> this command is commented out 

 <Pause> 60 s ;allow the syringe to run for 60 s 

 Reagent Syringe <Stop> ;stop the syringe 

 <Loop> Fill_Syringe 10  
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APPENDIX A. MENUS, TOOLBARS, WINDOW CONTROLS 

Menu Bar 
The menus contain the following functions:  

File Open, Close, Save, Print or create a new automated process.  

Edit Cut, copy or paste text while editing an automated process.  

View Choose which uProcess windows and toolbars are displayed. 

Actions Run, Pause or Stop an automated process, control hardware communications, and 
update firmware. 

Click and drag the three dots at the left of the menu bar to tear it from the main window as a 
floating palette. Click and drag the floating palette back into the main window to re-dock it. 

Toolbar 
Toolbar buttons provide one-click shortcuts to common tasks. Buttons are gray when those 
functions are not currently available. 

 
Figure 34. uProcess Toolbar Buttons. 

 New (ctrl-n) Create a new automated process 

 Open (ctrl-o) Open an existing automated process 

 Save (ctrl-s) Save the current automated process 

 Cut (ctrl-x) While editing an automated process, delete selected text and place it 
on the clipboard 

 Copy (ctrl-c) While editing an automated process, copy selected text to the 
clipboard 

 Paste (ctrl-v) While editing an automated process, paste text from the clipboard 

 Print (ctrl-p) Print the text of an automated process 

 About uProcess Find the uProcess version number. This window also contains links to 
the electronic version of this User Manual, the LabSmith web site, and 
LabSmith tech support. 

 
 Run/Pause/Quit Control the progress of an automated process. 
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 Stop all devices Stop all activity of all uProcess devices. 

 Re-scan devices Check for all connected uProcess devices. 

 Online Establish communication between the EIB and computer. 

Tip: You can also use keyboard shortcuts, shown in parentheses in the list above, to 
perform the commands. 

To toggle toolbar buttons on or off, click the down arrow on the right side of the toolbar, then 
choose Add/Remove Buttons>Standard. Choose Reset Toolbar to show all buttons. 

Click and drag the three dots at the left side of the toolbar to tear it from the main window as a 
floating palette. Click and drag the floating palette back into the main window to re-dock it. 

Choose View>Toolbars and Docking Windows>Standard to show or hide the toolbar.  

Tooltips 
Each toolbar button (and many other buttons in uProcess) includes tooltip text that appears 
when you position your cursor over the button. Tooltips explain a tool’s function. Choose 
View>Verbose Tooltips to view more extensive descriptions (Figure 35). 

 
Figure 35. Tooltips Provide Helpful Tool Descriptions. 

Customizing the Dashboard 

Show/Hide Dashboard Elements 
From the View menu choose Toolbars and Docking Windows. From this menu option you 
can choose to show or hide the toolbar, uDevices Window/Sequencer Window and Output 
Window. 

Auto‐Minimize Windows 

Click the “push-pin” button at the upper right of the uDevices Window/Sequencer Window 
or the  Output Window to minimize the window to the edge of the screen. Roll over a 
minimized window to make it reappear; it will automatically minimize when you roll the cursor off 
of the window. The push-pin button will be horizontal in this “auto-minimize” mode. Click the 
button again to turn it vertically and disable auto-minimizing. 

Detach, Dock and Re‐Position Windows 
Click and drag the top of the uDevices Window/Sequencer Window or the Output Window to 
detach it from the Dashboard and create a floating window. Drag the floating window over the 
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Dashboard to dock it. Positioning guides will appear as you do so to help you attach the window 
at the top, bottom, left or right of the uProcess Dashboard (Figure 36). 

 
Figure 36. Positioning Guides for Re-docking a Window. 
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APPENDIX B. MAINTENANCE 

Updating Firmware 
The firmware for all uProcess devices can be field updated as follows: 

1. Download the latest version of uProcess software from www.labsmith.com. 
2. Choose Actions>Firmware>Update All Firmware. uProcess will upload the latest 

firmware associated with the installed software to all connected syringe pumps and 4VM 
manifolds. Devices that are not attached will not be updated. 

Note:  You can update the firmware for a particular device by clicking the Configuration 
button in the Device Control Panel. 

Valve Actuation Profile Settings 
uProcess devices are factory configured for optimal performance. From time to time it may be 
necessary to access and adjust these settings. To do so, from the Device Control Panel click 
the Configuration button, which will open one of the Configure Device dialog boxes shown in 
Figure 37. 

Note: Contact LabSmith before changing any of the Actuation Profile Settings. 

  
Figure 37. Configure Device Dialog Box for a Syringe Pump and Valve Manifold. 

Changing the Syringe Pump Glass Assembly 
The SPS01 syringe glass and plunger can be removed from the pump body to be cleaned or 
exchanged with a different syringe size. To remove the syringe glass and plunger: 

1. Supply power to the syringe pump. 

2. In the uProcess uDevices Window, select the syringe. 

http://www.labsmith.com/�
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3. Enter a Set Point of 0 to extend the syringe plunger to the 0 volume position (Figure 
38). 

 
Figure 38. Set the Set Point to 0 and click Apply to extend the plunger. 

4. Click Offline to take the syringe offline. 

5. Unplug the syringe from the breadboard. 

6. Using the supplied hex wrench, loosen the screw located on the top side of the syringe 
(Figure 39). 

 
Figure 39. Loosen the Retaining Screw. 

7. Gently pull the syringe glass straight out of the syringe body, being careful not to bend 
the syringe plunger. 

8. While holding the wide end of the plunger installation wrench, insert the wrench around 
the plunger tip and into the syringe until it engages with the hex head at the base of the 
syringe plunger (Figure 40). 

 
Figure 40. Plunger Installation Wrench inserted into syringe. 

CAUTION:  Be very careful not to damage Teflon end of the plunger. Damage to the plunger 
can cause the syringe to leak.  

9. Turn the wrench counterclockwise approximately two revolutions to unscrew the plunger. 

10. Gently pull the wrench and plunger out of the syringe. 



 

47 

CAUTION: Do not operate the syringe without a plunger installed. Doing so can damage the 
syringe.  

To install the syringe glass and plunger: 

1. While holding the wide end of the plunger installation wrench, insert the plunger 
assembly into the wrench such that the hexagonal feature on the plunger is engaged 
with the wrench.  

2. Gently insert the plunger assembly into the syringe and screw onto the shaft until hand 
tight (approximately two revolutions). 

3. Carefully press the tapered glass syringe over the plunger assembly and into the syringe 
until it is seated in the syringe body.  

4. Use the hex wrench to tighten the screw located on the top side of the syringe.  

5. Gently pull on the syringe glass to ensure it is secure in the syringe body. 

6. The glass size value must be input in the software each time you change the glass size 
to allow uProcess to display and compute correct volumes and volume flow rates. To 
select the correct glass size: 

7. Click on the device in the uDevices Window. 

8. Select Configuration. 

9. Choose the syringe pump glass size from the Size drop-down list.  

10. Follow instructions for calibrating, below. 

CAUTION:  Ensure you are using the correct size plunger for your syringe glass. 

Calibrating the Syringe Pump 
Each SPS01 syringe pump is calibrated before shipment. However, each glass/plunger 
assembly may have slight length variations (up to 1%), and there can also be variations in the 
placement of the glass in the syringe body.  

Each time the syringe glass is removed or moved the syringe pump should be recalibrated. 
Calibrating the syringe pump allows uProcess to find the plunger stopping point, thereby 
minimizing the dead volume within the syringe and allowing correct calculation of the syringe 
volume. 

Note:  Calibrating the syringe will run the syringe to its maximum extents and will update its 
calibration values. The procedure may take up to 1 minute. 

To calibrate the syringe: 

1. Select the device in the uDevices Window. 

2. Select Configuration to open the Syringe Pump Configuration dialog box (Figure 42). 
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Figure 41. Syringe Pump Configuration Dialog Box. 

3. Click the Calibrate button.  

4. Select OK to store the values.  

Care of the Syringe Glass and Plunger 

Plunger Care 
Do not apply excessive force to move a plunger. Too much pressure can irretrievably bend the 
plunger or easily crack the syringe’s glass barrel. 

Avoid touching the plunger with your fingers. Abrasions, scratches, or oil due to handling the 
plunger with your fingers may interfere with proper plunger operation. 

To minimize the chance of damage or contamination, do not store the plunger outside the glass. 
Use caution when reinserting the plunger into the barrel using the plunger installation tool.  

For best results, dip the PTFE plunger tip into your solvent to re-wet it prior to reinserting the 
plunger into the barrel. 

Cleaning, Sterilizing, Autoclaving, and Disinfecting 
 
Cleaning 
To clean syringes, it is best to use solvents known to be effective in solvating the sample. 
Preferred cleaning agents are non-alkaline, non-phosphate and non-detergent based. A 
biodegradable, non-phosphate, organic Cleaning Concentrate is available from Hamilton (Part 
No. 18311). 

Rinse the syringe after use with an appropriate solvent or cleaning agent. Following the use of a 
cleaning agent, rinse the syringe with deionized water and finally acetone. Wipe the exterior 
surfaces of the syringe barrel and needle dry with a lint-free tissue. Make sure that there is no 
residual cleaning agent in the syringe before using or storing the syringe. Do not soak or 
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submerse the entire syringe in any cleaning agent. Prolonged contact with cleaning agents may 
damage bonded parts. 
 
Sterilizing 
Syringes may be sterilized with appropriate sterilizing agents such as ethylene oxide. 
 
Autoclaving 
Syringes can be autoclaved up to a temperature of 115 ºC. However, please be aware that over 
time autoclaving will shorten the syringes’ life expectancy. Avoid rapid temperature changes, 
which can lead to splitting of the syringe’s glass barrel. Stainless steel expands faster than glass 
upon heating, so for most terminations, autoclaving strains glued surfaces and may eventually 
lead to adhesive deterioration and leakage. The plunger should be removed from the syringe 
before autoclaving. 
 
Disinfecting 
If your application only requires disinfection, we recommend the use of Microcide SQ (Hamilton 
Part. No. 3995-01). This disinfectant is rated to eliminate the majority of commonly encountered 
bacteria, viruses, fungus, and mildew. Use of other common chemicals like 10% bleach, 
acetone or ethanol are acceptable but are not rated to be as effective as Microcide SQ. 

Capillary and Tubing Installation Guide 
LabSmith’s CapTite™ one-piece fittings enable connection of components (valves, syringe 
pumps, interconnects, bonded-port connectors, Luer Locks, and cartridges) to 360um capillary, 
1/32” tubing, or 1/16” tubing. To install the capillary or tubing: 

1. Cut the capillary or tubing to length. Please refer to the capillary or tubing packaging for 
cutting instructions. 

2. Insert the capillary into the nut end of the one-piece fitting until the tubing extends 
through the tapered ferrule end approximately 2 mm. 

3. Insert the one-piece fitting into the component and turn the fitting to finger-tighten.  

CAUTION:  Do not over-tighten the fitting. Fittings should only be “finger-tight” to avoid 
damage (the 1/8” hex wrench can be used to tighten or loosen difficult-to-reach 
fittings). 

4. Gently pull on the capillary tubing to ensure that it is held securely by the fitting. If the 
capillary comes free, loosen the fitting and repeat steps 2 and 3. 

5. If the fitting leaks or the capillary cannot be secured, the following troubleshooting items 
should be checked prior to further tightening the fitting: 

a. The capillary may be cut too short and so it is not protruding through the end of 
the fitting when installed 

b. The capillary may not have a “clean cut”. An angled or jagged edge will cause 
the fittings to leak 

c. Broken capillary or other debris may be stuck inside the fitting or component. Try 
flushing the port from the opposite side to clear the debris. 

6. If pressures greater than 10,000 psi are required, first finger-tighten all fittings and test 
for leaks at low pressure. Then, use the 1/8” hex wrench to tighten the fittings 
approximately ¼ extra revolution. 
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Figure 42 shows capillaries that are properly and improperly installed: 
- Red capillary does not protrude through the one-piece fitting. The fitting 

will leak, and also there is a chance of compressing and damaging the tip 
of the one-piece fitting during installation. 

- Yellow capillary may properly seal, but the capillary is not fully seated in 
the interconnect, creating dead volume. 

- Green capillary is properly installed.  

 
Figure 42. T-Interconnect Showing Properly Installed Capillary (Green), Improperly Seated Capillary 

(Yellow), and Capillary Not Protruding Through Fitting (Red). 
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